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Preface

Thank you for placing your trust in this devolo product.

The dLAN 200 AV from devolo is the home plug-in device for high requirements
on data transfer, such as HDTV streaming, Internet telephony and fast Internet.
With a transfer rate of 200 Mbps, the dLAN 200 AV transforms the home elec-
trical system in no time into a fast network —thanks to the powerful 128-bit AES
encryption with maximum data security. Whether in the office or at home —
devices such as IP phone, router, set-top box or the computer can be connected
with the dLAN 200 AV using the available Ethernet interface. On top of that, the
range of 200 meters creates a high degree of flexibility.

About this manual

This manual contains all the information you need about your dLAN 200 AV
from devolo. It tells you how to set up and configure your dLAN 200 AV device.
The 'All about the network' chapter also contains examples of applications for
the dLAN 200 AV.

Exacting manufacturing standards and stringent quality control are the basis for
high product standards and consistent quality to ensure your fullest satisfaction
with this dLAN 200 AV.

This documentation was compiled by several members of our staff from a variety
of departments in order to ensure you the best possible support when using your
product.

Additional information in the Internet at ‘www.devolo.com’

Our online services (www.devolo.com) is available to you around the clock
Should you have any queries or require any further support.

Package contents

Please ensure that the delivery is complete before beginning with the installation
of your dLAN 200 AV:

® dLAN 200 AV

@ Ethernet cable

@ Printed information leaflet

® (D with online documentation and software

devolo reserves the right to change the package contents without prior notice.
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Description of the symbols
Here we briefly describe the meaning of the symbols used in this manual.

Very important notice which, if ignored, may lead to damage.

Important notice which should be heeded.

Additional information which is useful to know, but not vital.
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1.1

Introduction

In this chapter, we will provide an overview of the new dLAN technology and
introduce the dLAN 200 AV briefly.

What exactly is dLAN?

There is now a new alternative to the well-known wired LAN and Wireless LAN
network technologies currently used in home and office networking: dLAN
(direct Local Area Network, i.e. directly networked). dLAN is home and office
networking using the electric wiring already installed in the building.

Cost factor and transmission quality

dLAN is an economical and easy-to-use networking technology. You don't need
to lay cables and you can connect to the home network at every power point.

The dLAN standard modulates and demodulates additional frequencies on the
power lines. Modulation and demodulation is a well-known and proven method
of data transmission, which has been in use in other applications for a number
of years. Now it is used to set up Internet and network accesses in the home or
office. Depending on the damping factor, distances of at least 200 meters can
be covered.

With a maximum data rate of 200 Mbps and symmetrical upload and download
speeds, dLAN is comparable to traditional Ethernet network solutions and the
current WIFI" wireless standard for home applications.

Data security and radiation

128-bit AES encryption is used, which guarantees secure data transfer within
the network.

dLAN devices from devolo meet the stringent EU industrial standards and com-
ply with the current standards for electromagnetic radiation.
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What does the dLAN 200 AV have to offer?

Powerful and flexible

For the first time, the dLAN 200 AV offers a transfer rate of 200 Mbps which
makes it ideal for high requirements, such as HDTV streaming, Internet tele-
phony and fast Internet. When connected to an electrical outlet, it changes the
home-based electrical system in no time into a fast network with high data
throughput. And all of that with optimum transfer and maximum data security
using the powerful 128-bit AES encryption. Whether in the office or at home —
devices such as IP phone, router, set-top box or the computer can be connected
with the dLAN 200 AV using the available Ethernet interface. On top of that, the
range of 200 meters creates a high degree of flexibility.

You can find examples of possible networks in the chapter "All about the net-
work'.

Simple installation

@ Connect the dLAN 200 AV to the computer or to another network device via
the supplied Ethernet cable.

® Connect the dLAN 200 AV to the power supply grid.

@ |nstall the devolo dLAN 200 AV software.

@ That's it!

Ethernet connection

The dLAN 200 AV has an Ethernet port for connecting to a device in the network
(e.g. computer, notebook, IP phone, router, switch, set-top box etc.).

Status display

The control lamps (LEDs) of your dLAN 200 AV display the connection status,
and provide status regarding the function of the data transmission. The dLAN
200 AV features 3 status lights.

devolo dLAN 200 AV D
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2 Connection and startup

This chapter covers the connectors and display elements of your dLAN 200 AV
and explains how to connect the device.

2.1 System requirements

® Operating systems: Windows 98, Windows Me, Windows 2000, Windows
XP, Linux, Mac OS X and any other operating system with network support
® Ethernet connection

Please note that your computer or other device must feature a network adapter
with an Ethernet port.

7o set up a dLAN 200 AV network, you need two dLAN 200 AV devices.

BEIO

2.2 Connection and display elements

The dLAN 200 AV features 3 control LEDs as well as an Ethernet port:

Ty
Vg,

Power
is lit green when the dLAN 200 AV is in Power Save mode.

s lit red if connected to the dLAN 200 AV network,
flashes red when data are being sent or received over the
power lines.

(D Is lit red when the dLAN 200 AV is ready for operation;
O
s

dLAN Link/Act
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ETH Link/Act ] Is lit red whenever an Ethernet connection of 100 Mbps exists;
flashes red when data are being sent or received.

This is the connection point on the dLAN 200 AV for connect-

ing it to a computer or another network device with the net-
work cable (included).

Make sure that all of the dLAN 200 AV devices that you want to add to your net-
work are also connected to the power supply grid. After about 20 minutes, a
dLAN 200 AV switches into stand-by mode unless there is an active network
device (e. g. computer) connected to the Ethernet interface. dLAN 200 AV
devices in stand-by mode are not accessible over the power supply grid. As soon
as network device (e.g. computer) connected to the Fthernet interface is
switched on again, your dLAN 200 AV can also be reached again via the electric

supply.

Ethernet port

Connecting the dLAN 200 AV

In this section, we will show you how to connect the dLAN 200 AV to a com-
puter.

(@ With the computer running use the included network cable to connect the
dLAN 200 AV to an Ethernet port of the computer.

(@ Plug the dLAN 200 AV into a convenient power socket.

(® Continue with the installation of the devolo dLAN 200 AV software. For
more information, refer to the chapter on 'devolo dLAN 200 AV software'.

No drivers are required for running the dLAN 200 AV.
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3.1.3

devolo dLAN 200 AV software

This chapter introduces you to the dLAN configuration wizard, Informer, Easy-
Share and EasyClean devolo tools and describes how to install them.

Overview of the devolo software

dLAN configuration wizard

The dLAN configuration wizard helps you to build and change your encrypted
dLAN network. With its help, you can add dLAN 200 AV to your network. It
allows you to configure all dLAN adapters on the network from a central loca-
tion, such as from a single workstation. For the encryption process, you need the
security IDs of the dLAN 200 AV (provided on the underside of unit) and a net-
work password of your choosing, which you will assign.

The password set up initially by devolo is HomePlugAV. (case sensitive)

devolo Informer

The Informer displays information about all the dLAN 200 AV devices in your
network, such as their MAC addresses and current connection rates.

Only when data is transmitted via the dLAN 200 AV, the connection rates are
displayed in the Informer

The MAC address (Media Access Control) is a serial number, and is unique for
each device. It is hard-coded in each device and cannot be altered. You can find
the MAC address on the bottom of the device.

devolo EasyShare

EasyShare is a file-sharing and chat tool for your local network. It allows you to
exchange files easily between local Windows computers. The chat function
allows instant communication between all network users.
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devolo EasyClean

Microsoft Internet Explorer stores files in a cache on your hard drive while you
surf the Internet. With EasyClean, you can determine which of these unwanted
files you would like to delete.

Installing the devolo dLAN 200 AV software

(@ Put the enclosed devolo product CD in your CD-ROM drive.

(@ From the CD setup, select 'Install dLAN 200 AV'. Windows starts the wizard.
Confirm by clicking Next.

(® Select 'Standard Installation' to install the complete devolo dLAN software
package. Then, click Next.

If you would like to choose the software components to be installed yourself,
select ‘Custom Installation’. Then, click Next

@ Terminate the installation by clicking Finish.

Windows may prompt you to reboot your computer after the installation has

been completed.

(® After the installation has been completed successfully, start the devolo tools
by clicking Start > Programs P> devolo P> dLAN configuration wizard,
EasyClean, EasyShare or Informer.

Configuration of the dLAN network using the
dLAN configuration wizard
Please have the previously noted dLAN 200 AV security IDs ready. The dLAN

configuration wizard requires them for configuration of the network. You will
find the security ID on the bottom of the device.

@ Start the dLAN configuration wizard under Start > Programs »> devolo p
dLAN configuration wizard.

(@ Confirm with Next. The dLAN configuration wizard starts the network anal-
ysis and searches for dLAN 200 AV on your network.

Make sure that all of the dLAN 200 AVdesk that you want to add to your network
are also connected to the power supply grid. If no active network device is con-
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nected to the Ethernet port, a dLAN aaapter will go into standby mode after
about 20 minutes. It cannot be configured while in standby mode. As soon as
network device (e.g. computer) connected to the Ethernet interface is switched
on again, your dLAN 200 AVdesk can also be reached again via the electric sup-

ply.

® |In the following dialog box select a common password for your dLAN net-
work and confirm your input with Next.

=IO

The password set up initially by devolo is HomePlugAV (case sensitive).

@ The dLAN 200 AV connected directly to your computer is detected automat-
ically. All other dLAN adapters have to be entered manually. Enter in
sequence the security IDs of the dLAN 200 AV that are to be included into
a network and click Add. Click Next when you have entered all desired
dLAN 200 AV.

dLAN Configuration Wizand

Add dLAN adapters
Add other dLAN adapters that are addressable via the power supply grid.

To add dLAN adapters that are addressable via the
power supply ko your network, enter their security IDs ""‘_'"_"" C E
and click the Add buttan, LAN

Sacurity 1D
The security ID is printed on a small label on the X
battom of the adapter, I

Security ID:
HARD - WARE |- | EINS - 2301

-DDD:DB:SB:SS:ZS:DZ {on this computer)

[ < Back ][ Mext = ][ Cancel ]

(® Exit securing your network by clicking Finish. Your dLAN network is now
secure against unauthorized access from outside.

The configuration of the dLAN 200 AV network can be changed or updated at
any time. 7o do this repeat the configuration process as described above.

=IO
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3.4

Overview in the dLAN 200 AV network with the
devolo Informer

Due to the Informer you always have an overview of all dLAN 200 AV devices in
your dLAN 200 AV network. The Informer shows the dLAN 200 AV connected
directly to the computer as well as all dLAN 200 AV devices that are included
into the same dLAN 200 AV network.

Gerdt  Ansicht  Hilfe

] duan 200 Av
0 MAC-Adresse: 00:B0:36:19:93:02
%) dLAN 200 AV (Ober das Stromnetz)
0 MAC-Adresse: 00:B0:36:19:93:07
‘L} Upstream-Rate: 197 Mbit/s
4k Downstream-Rate: 194 Mbits

The Informer displays information about all dLAN 200 AV devices in your net-
work, such as their MAC addresses for dLAN and current transfer speeds. Via
Device > Rename you can change the name of the selected device.

Right-clicking on one of the dLAN 200 AV devices opens a context menu in
which the following commands are available:

@ 'Rename’ opens a dialog in which you can assign a new name to the device.

@ 'Start dLAN configuration wizard' opens a dialog in which you can add new
dLAN 200 AV devices to the dLAN 200 AV network and assign the network
password.

Informer displays only those dLAN 200 AV devices which are connected to the
power supply and added to your dLAN 200 AV network. After about 20 minutes,
a dLAN 200 AV switches into stand-by mode unless there is an active device (e.
g. computer) connected to the Fthemet interface. dLAN 200 AV devices in
stand-by mode are not shown in Informer. As soon as the device (e. g. com-
puter) that is connected to the Fthemet interface is switched on again, your
dLAN 200 AV can be accessed again via the power supply grid and is displayed
in the Informer.

devolo dLAN 200 AV D
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3.5.1
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Communication in the network using
devolo EasyShare

All users on the local network who have started EasyShare are automatically rec-
ognized by the program and listed:

L devoko CasyShare
Ble Jook Help

=y

=]

|_swn £ ¥

Configuration

The EasyShare software provides two easy wizards, which will guide you quickly
and easily through the configuration process: the first setup wizard, which starts
automatically the first time the program is started, and the sharing wizard,
which allows you to add shared items at any time. The individual functions of
the EasyShare software are described here:

Folder sharing

To share data with others, a EasyShare network user has to make the data avail-
able in a shared folder. When a folder is shared, all of its files as well as the files
of all its subdirectories become available to all users on the EasyShare network.
Folders can be shared either by using the initial setup wizard, which opens auto-
matically the first time the EasyShare is started, or by using the sharing wizard.
You can open the sharing wizard by clicking the Add share button, or by select-
ing File » Add share from the menu.

( | devolo dLAN 200 AV
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Options
Every computer has a name. When EasyShare is first installed, you can assign a

new name to your computer or use the default name suggested by the operating
system. Your computer is visible by this name to all EasyShare users.

The computer name can be changed at any time by clicking the Options button
or by selecting Tools » Options from the menu.

Refreshing shared folders

To view (newly) shared folders of other EasyShare network users, select File >
Refresh from the menu, or Refresh from the context menu (right mouse button).
The contents of all shared folders will appear in the top right-hand window.

Downloading files

To download shared files from other EasyShare network users, select the com-
puter belonging to the user and then mark the shared folder for that user. The
upper-right window then lists all the contents of the folder. From the list, mark
the files and/or folders that you want to download and then select File
Download from the menu, or Download from the context menu (right mouse
button). Choose a target folder on your computer and confirm by clicking OK.
The files are now downloaded to your computer. The status of the download is
displayed in the lower-right window entitled 'Data transfer in process'.

Data transfer in process

All 'Data transfer in process' are displayed in the lower right window and disap-

pear from the screen once they are finished.

@ The 'Name' column indicates the name of the file being downloaded.

@ The 'Status' column shows the current transfer progress and the transfer
speed.

@ The 'Host' column shows the computer from which the file is being down-
loaded, or to which it is being uploaded from your computer.

You can cancel the current download by clicking the file and selecting Cancel
from the context menu (right mouse button).

Chatting

The lower left window functions as a chat room, which is visible and accessible
to all EasyShare users on the local network. Users can "chat" by writing mes-
sages and clicking Send.

devolo dLAN 200 AV D
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3.6 Maintain your privacy with devolo EasyClean

With EasyClean, you can delete the cached files listed below. Select the check-
boxes of the file types you would like to remove, then click Delete.

# devolo EasyClean g|

Please select the data for deletion,

Internet Explorer

é Cookjes are small files that can be used to store the settings for web sites, e.qg.
ordered goods,

Delete temporary Internet files

Internet Explorer stores the files from web sites to accelerate the display of the
pages.

Delete history

Every web site that you visited in the last bwo to three weeks is stored in the
History Folder,

Delete stored Form data

The Internet Explorer provides the option of filing in your entries automatically,
Ta da this, it remembers the data that you bype in.

Delete stored passwords
The Internet Explorer provides the option of filing in your access data
automatically,

File: lists
2 Delete the list of recent files
‘arious lists of the files recently opened or websites recently visited are saved

on the computer, These include the address list in the Internet Explorer and the
list of recently run programs,

[ Delete ] [ Close ]

® Cookies—Many websites store small files on your computer, so-called

cookies. These files may contain personal information such as log-in data,
passwords or credit card numbers.

® Temporary Internet files—Temporary files are stored on your hard drive

while you surf the Net. Over time, these files take up a considerable amount
of space.

@ History files—Internet Explorer records your surfing activity over a period

of days or weeks. This can be practical, but it also takes up space and can
be undesirable in many cases.

@ Stored form information—Internet Explorer stores information that you

enter in forms and can auto-complete this information in the future.

( | devolo dLAN 200 AV
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® Stored passwords——Passwords can also be stored and automatically
inserted together with usernames in subsequent log-in procedures. While
this is convenient, it's also dangerous—especially in connection with bank
transactions. Sensitive information such as this should only be stored locally
in special programs designed for this purpose.

@ Document history—Internet Explorer maintains lists of open documents
and visited websites. This information is generally no longer needed.

Please note that FasyClean only supports Microsoft Internet Explorer.

devolo dLAN 200 AV D
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4 All about the network
This chapter contains examples for possible network designs in home or in
office.

4.1 Internet standalone solution—Option 1

Workstation with Internet connection over a DSL modem (Ethernet)
dLAN 200 AV dLAN 200 AV

Modem (Ethernet) ‘ L = 4

4.2 Networking—Option 2

Connection of two workstations
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4.3

4.4
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Networking—Option 3

Connection of a high-speed IP-TV application to the Internet via a DSL modem

(Ethernet)

Networking—Option 4

_______

Connection of an IP telephone and a high-speed IP-TV application to the Inter-

net via a DSL modem router

For more answers to frequently asked questions (FAQs), please visit our website

at www.devolo.com.

devolo dLAN 200 AV D
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5 Appendix

5.1 Technical data

This table has detailed information for those interested.

dLAN 200 AV

Standards

Protocols

Transfer rate
Transfer procedure
Modulation

Data stream
Range

Security

LEDs

dLAN connection
Computer interface
Power consumption
Power supply
Environment

System requirements

Operating systems

CE conformity
Design

Warranty

Ethernet specification IEEE 802.3, IEEE 802.3x, IEEE 802.3u
Auto MDI/X

HomePlug AV

TDMA, CSMA/CA

200 Mbps

Asynchronous

OFDM—1155 carrier, 1024/256/64-QAM, QPSK, BPSK
Ethernet <-> power supply

200 m via power supply

128-Bit-AES encryption via power supply

Power

dLAN Link/Act

Ethernet Link/Act

Standard power plug

R145

5.5 VA (max.)

100 — 240 V AC, 50/60 Hz

Humidity (non-condensing): 10-90%

Ethernet interface

Windows 98, Windows Me, Windows 2000, Windows XP.
Linux, Mac OS X or any other operating system with network

support

CE-compliant in accordance with the technical requirements
of R&TTE for all EU countries and Switzerland

Plastic housing
80 x 65 x 40 mm (height x width x depth)

3 years
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5.2

Important safety instructions

All safety and operating instructions should be read and understood before
using the device, and should be kept for future reference.

Never open the dLAN 200 AV. There are no user-serviceable parts inside the
dLAN 200 AV.

Do not try to service this product yourselfl Contact qualified technicians each
and every time your device needs maintenance. There is a risk of electric shock!

Use the dLAN 200 AV in a dry location only.

Do not insert any objects into the openings of the dLAN 200 AV.

To disconnect the dLAN 200 AV from the power supply grid, pull the power

plug.

Do not keep the dLAN 200 AV in direct sunlight.

Slots and openings on the case serve as ventilation. Never block or cover

them.

Never set up the dLAN 200 AV near a heater or radiator.

The dLAN 200 AV should be located only where sufficient ventilation

according to the instructions of the manufacturer can be ensured.

Disconnect the dLAN 200 AV from the power supply grid before cleaning.

Use a moist towel to clean the device. Never use water, paint thinner, ben-

zene, alcohol or other strong cleaning agents when cleaning the device, as

these could damage the case.

Never use the dLAN 200 AV with a power supply that does not meet the

specifications provided on the rating plate. If you do not know what type of

power supply you have at home, contact your dealer or energy supplier.

In the event of damage, disconnect the dLAN 200 AV from the power supply

grid and contact customer service. This applies, for example, if

O the power cable or plug is damaged.

O liquid has been spilled on the dLAN 200 AV or objects have fallen into
the device.

O the dLAN 200 AV has been exposed to rain or water.

O the dLAN 200 AV does not work, even though the operating instructions
have been followed properly.

O the dLAN 200 AV's case is damaged.

devolo dLAN 200 AV D
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5.3 CE conformity
This product complies with the technical requirements of the 1999/5/EC Direc-
tive (RGTTE) and the other relevant provisions of the FTEG, and it is designed for
use in the EU and Switzerland.

The product is class B equipment. This equipment may cause interference with
radio waves in home use; if this occurs the operator may be required to take cor-
rective action.
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5.4 Declaration

of conformity

C€

KONFORMITATSERKLARUNG

Hersteller:
Manufacturer:

Produkt:
Product:

Typnummer:
Type number:

Verwendungszweck:
Intended purpose:

Richtlinie:
Directive:

DECLARATION OF CONFORMITY

devolo AG
Sonnenweg 11
52070 Aachen

devolo dLAN®200 AV
MT2076

PLC zu Ethernet
PLC to Ethernet

1999/5/EG (R&TTE)
1999/5/EC (R&TTE)

Das Produkt entspricht den grundlegenden Anforderungen und Bestimmungen der
folgenden Normen und Methoden:
The product complies with the essential requirements and provisions of following standards and methods:

Sicherheitsanforderungen:
Safety requirements:

Immunitatsanforderungen:
Immunity requirements:

Emissionsanforderungen:
Emission requirements:

EN 60950-1:2001

EN 55024:1998+A1:2001+A2:2003

EN 55022:1998+A1:2000+A2:2003 (Class B)
und Expert Opinion vom Competent Body EMV
and Expert Opinion by Competent Body EMC

Diese Erklarung wird verantwortlich abgegeben durch:

This declaration is submitted by:

Aachen, 4. Oktober 2006
Aachen, 4" October 2006

P

Heiko Harbers
Vorstandsvorsitzender
CEO
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5.5 Warranty conditions

The devolo AG warranty is given to purchasers of devolo products in addition to the warranty con-
ditions provided by law and in accordance with the following conditions:

1

a)

2

Warranty coverage

The warranty covers the equipment delivered and all its parts. Parts will, at devolo's sole dis-
cretion, be replaced or repaired free of charge if, despite proven proper handling and adher-
ence to the operating instructions, these parts became defective due to fabrication and/or
material defects. Alternatively, devolo reserves the right to replace the defective product with
a comparable product with the same specifications and features. Operating manuals and pos-
sibly supplied software are excluded from the warranty.

Material and service charges shall be covered by devolo, but not shipping and handling costs
involved in transport from the buyer to the service station and/or to devolo.

Replaced parts become property of devolo.

devolo is authorized to carry out technical changes (e.g. firmware updates) beyond repair and
replacement of defective parts in order to bring the equipment up to the current technical state.
This does not result in any additional charge for the customer. A legal claim to this service does
not exist.

Warranty period

The warranty period for this devolo product is three years. This period begins at the day of delivery
from the devolo dealer. Warranty services carried out by devolo do not result in an extension of the
warranty period nor do they initiate a new warranty period. The warranty period for installed
replacement parts ends with the warranty period of the device as a whole.

4

Warranty procedure

If defects appear during the warranty period, the warranty claims must be made immediately,
at the latest within a period of 7 days.

In the case of any externally visible damage arising from transport (e.g. damage to the hous-
ing), the person carrying out the transportation and the sender should be informed immedi-
ately. On discovery of damage which is not externally visible, the transport company and the
sender are to be immediately informed in writing, at the latest within 3 days of delivery.
Transport to and from the location where the warranty claim is accepted and/or the repaired
device is exchanged, is at the purchaser's own risk and cost.

Warranty claims are only valid if a copy of the original purchase receipt is returned with the
device. devolo reserves the right to require the submission of the original purchase receipt.

Suspension of the warranty

All warranty claims will be deemed invalid

a)
b)

9)

if the label with the serial number has been removed from the device,

if the device is damaged or destroyed as a result of acts of nature or by environmental influ-
ences (moisture, electric shock, dust, etc.),

if the device was stored or operated under conditions not in compliance with the technical
specifications,

if the damage occurred due to incorrect handling, especially to non-observance of the system
description and the operating instructions,

if the device was opened, repaired or modified by persons not contracted by devolo,

if the device shows any kind of mechanical damage, or

if the warranty claim has not been reported in accordance with 3a) or 3b).
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Operating mistakes

If it becomes apparent that the reported malfunction of the device has been caused by unsuitable
hardware, software, installation or operation, devolo reserves the right to charge the purchaser for
the resulting testing costs.

Additional regulations

The above conditions define the complete scope of devolo's legal liability.

The warranty gives no entitlement to additional claims, such as any refund in full or in part.
Compensation claims, regardless of the legal basis, are excluded. This does not apply if e.g.
injury to persons or damage to private property are specifically covered by the product liability
law, or in cases of intentional act or culpable negligence.

Claims for compensation of lost profits, indirect or consequential detriments, are excluded.
devolo is not liable for lost data or retrieval of lost data in cases of slight and ordinary negli-
gence.

In the case that the intentional or culpable negligence of devolo employees has caused a loss
of data, devolo will be liable for those costs typical to the recovery of data where periodic secu-
rity data back-ups have been made.

The warranty is valid only for the first purchaser and is not transferable.

The court of jurisdiction is located in Aachen, Germany in the case that the purchaser is a mer-
chant. If the purchaser does not have a court of jurisdiction in the Federal Republic of Germany
or if he moves his domicile out of Germany after conclusion of the contract, devolo's court of
jurisdiction applies. This is also applicable if the purchaser's domicile is not known at the time
of institution of proceedings.

The law of the Federal Republic of Germany is applicable. The UN commercial law does not
apply to dealings between devolo and the purchaser.

devolo dLAN 200 AV D
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